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How to Schedule a patient… 
1. Click on the date you want to schedule the appointment on.  

2. Click on the time slot that best fits their needs  

3. Type in the patient’s name and then click search 

A. If the patient does not come up then search all clinics, if still not there do a quick add.  

B. For a quick add all you need is; first name, last name, phone number, and date of birth, 
however, you should attempt to get the address also. Enter and ss aa vvee. 

4. Select what the patient is coming in for, how long the appointment will be, and the referral 
source. (ie: Newspaper, Yellow pages, Physician Referral & doctor name, etc.) Then save 
that screen as well.  

5. The next screen is Appointment Confirmation so just check this screen and make sure the 
information is correct. Then save it.  

6. You will then notice the appointment you just made will appear on your scheduler.  
 

When a new patient comes in for their first appointment: 
1. Have them fill out the Patient Information Form 

2. Have them read and sign the Financial Policy. This includes the HIPAA statement. This 
should be printed on the back of the Patient Information Form. 

3. Make a copy of the front and back of all insurance cards 

4. obtain the Physician referral from the patient if it was not faxed by the doctor prior to the 
appointment. 

5. Prepare a new patient folder. 

6. Give all the above to the audiologist along with the Outcome/Charge Sheet form for the 
appointment. 
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How to edit the intake form… 
 
This must be done for each new patient and verified each time a patient comes in. 
 
1. Click on the patient’s name on the scheduler. (That will take you to the Appointment 

Summary screen) 
2. Click on the patient’s name on that screen (That will take you to the Patient Summary 

screen) 
3. Click on Edit Full Intake  

Things that need to be filled out are… 
1. Title (Mr. Mrs. Dr., etc)  These will be used with the mail merge function . 

2. Name (first, last, & middle initial) 

3. Suffix (Jr, Sr, MD, III, etc) 

4. Patient Type  

a. Prospect: (default) new patients. (automatically changes when HA is purchased)  

b. Current: patient to whom HCI has sold a hearing aid 

c. Competitive: Patient wearing HAs purchased elsewhere (enter HA info in pt file under 
current equipment) 

5. Gender (Male/Female) 

6. Date of Birth 

7. Home Phone Number (and any additional they want to give out) 

8. Home Address 

9. The Clinic should default to your clinic if not, select it from drop-down list (Carmel, 
Speedway, Etc.)  

10. Staff (Jessica, Kelly, Etc.) Make sure it is the provider the patient has the appointment with. 

11. Original Referral Source (TV, Yellow pages, friend, etc) Make sure this is correct.  

12. Employment Status (Retired, Full-Time, Part-Time, Etc) Must have. 

13. Student Status (Full-Time, Not a Student, Etc.) Must have. 

14. Marital Status (Widowed, Married, Etc.) Must have (If married put in spouses name and 
check mark if they are also a patient) 

15. Privacy section. Important. Verify that statement on back of Patient Information Form 
(Financial Policy page) is signed, and make sure a check mark is in by HIPPA Waiver 
Statement. If the patient is a child under 18 years of age clear the check mark next to “ok to 
send mail” so automatic mailings will not be mailed to the patient. Make sure this box is 
checked if the patient is to receive mail.  

16. Emergency Contact – may be left blank, may just be a phone number. Addresses should be 
complete, if given. 
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17. Responsible Party – if someone other than the patient is responsible for the patient’s bills, this 
section must be filled out completely and the “bill to responsible party” box should be 
checked. For example (Vocational Rehabilitation, lawyer, parent, guardian, etc) 

18. Background section  

a. Enter the patient’s primary doctor and referring doctor by selecting from the drop-
down list.  

b. If the doctor is not found on the drop-down list, you must obtain the doctor’s 
information and fill in the boxes on the drop-down list screen under the drop-down 
box. MUST HAVE: Doctor’s first and last name, Suffix (example: MD), UPIN #, NPI 
number (12 digits), Medicaid # (if patient has Medicaid insurance) NOTE: at some 
time in 2007 the only number required will be the NPI. Until that time, the “legacy” 
numbers are required (UPIN, Medicaid ID) 

c. REFERRING PHYSICIAN must be selected from the drop-down list in order for the 
information to be pulled into the HCFA claim form. 

19. Insurance (all their insurance information needs to be entered) 

a. If the Patient is the Subscriber, select “SELF” in Patient’s relationship to the insured: field. Sycle 
will fill in the patient’s information you entered at the top of the patient summary and 
pull it into the claim forms, but it will not be visible on the screen in front of you. 
Otherwise indicate the relationship by pulling from the drop-down list and enter the 
name, birth date, and address and phone number of the subscriber where indicated.  

b. If insurance is Medicare  

i. Use Payer Source: Medicare 

ii. If Medicare is the primary insurance, in Policy, Group or FECA #:  field type NONE 
(this will pull into the claim and certify to Medicare you verified there is no 
other insurance primary to Medicare) 

iii. Medicare ID #: copy exactly as on the insurance card, but delete the dashes (-) 
Example Medicare # 313-13-1234A would be entered as: 313131234A; 123-
45-6789C2 would be entered as 123456789C2 

c. If insurance is Blue Cross Blue Shield (BCBS) or Anthem 

i. Use Payer Source: Blue Cross/Blue Shield 

ii. Enter the complete id # (example: GMH 921737429) – claims will be denied if 
the alpha characters (“GMH” in the example) are not entered. 

iii. If patient has BC –GM. Call BC General Motors (GM) at (800) 992-1882 to 
verify patient is currently eligible for hearing aids on this date of service and 
annotate the NOTES: section (example: 03/14/7 last HA on 10/21/02, currently 
eligible – gjw.(initials of person entering the information)) 

d. If insurance is Medicaid  

i. Select the correct Medicaid company from the drop-down list (verify online at 
WebInterchange web site or over the phone at: )  

1. If the patient has “Spend down”, “ICF/MR”, “QMB”, “QMB – also”, a 
PCCM (Primary Care Case Management) doctor, or primary provider 
doctor record this information in the insurance NOTES: section.  
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a. NOTE: we can not see QMB patients. We can see QMB – also” 
patients.  

2. If the patient is PCCM, you must call the Physician and get their “2-
digit CERT code” for the date of service. Enter this code at the 
beginning of the appointment NOTES:  section on the Appointment 
Summary so it is visible to the claim biller when she creates the HCFA.  

ii. Use Payer Source:  Medicaid  (unless the insurance is Medicaid Anthem) 

iii. For Medicaid –Anthem DX, HA or DME use Payer Source:  Blue Cross/Blue Shield 

iv. Patient’s relationship to the insured: SELF 

e. If the patient is being seen for Vocational Rehabilitation 

i. Do not use the insurance section of the Patient Summary. Instead, enter the 
Voc Rehab office address in the Responsible Party: section and make sure you 
check next to Bill to Responsible Party – See the section on Voc Rehab. 

f. For other insurance companies  

i. Use Payer Source:  Commercial Insurance  

ii. If you are not sure if we can accept the patient’s insurance call the phone 
number on insurance card and ASK if they pay out of network providers, or if 
Hearing Center is in network with them. If we can not bill the insurance tell the 
patient before he/she is seen for the appointment. 

20. Save 
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How to check out a patient/make a purchase summary… 
 

1. Looking at the scheduler click on the patient’s name that you want to check out.  

2. Then click on Enter Outcome, and a new screen will pop up.  

3. You will then enter the diagnosis code and scroll down 

(The Audiologist will enter in the Outcome Notes and all of the information under 
Hearing Test) 

4.   Under Hearing Test Enter “did not test” (the audiologist can enter the testing information 
later, if need be. 

5.   Make sure under Privacy that the HIPAA signed box is checked, (Ok to send mail, and 
Ok to call should be unchecked for children an non-responsible adults.) 

6. Make sure under Mailing List that all boxes are checked, or select Do not send  if the 
patient is a child on which only testing was done.  

7. If there are purchases make sure that the “YES” box is filled in and then click save. (This 
will take you to the Purchase Summary page)  

8. At the bottom you will select what the patient had done on that day.  (ie: if the patient had 
an AA click on add tab next to services, then you would select the service on the service 
purchase screen and the price will automatically come up. Double check to make sure it is 
the correct price.) Then push save 

9. This will take you back to the Purchase Summary page; you will need to save this again.  

10. If the patient makes a payment on the date of service click on the payment tab.     (you 
will select how much they paid and their payment type)  Under description enter, 
“testing”, “service”, “hearing aid”, “batteries”, “ear mold”, or “accessories”. If they paid 
by check you can enter the check number after one of the above words) 

11. This will take you back to the Purchase Summary page.  ss aavv ee.  

12. Now you can print a receipt for your patient and one for daily batch.  

13. Then you can close out the screen   

IF the patient is fit with a hearing aid.  
Go to the Patient Summary (click on the patient name at the top of the Purchase Summary),  

1. Click on Custom Groups,  

2. Check the appropriate Custom Group for the six month reminders. (Example: patient is 
fit in May, then select the May/Nov 6 Mo Reminder custom patient group with a check 
mark.) & click ss aavv ee. 

3. Scroll down to the invoice and click the link to return to the Purchase Summary. 

4. Make sure a check mark is next to “Delivered to Patient” and the date of the fit is correct. 
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IF you will be filing with insurance  

Go to the bottom and where it says Due from Insurance click aa dd dd. (This part can be done after 
the patient leaves) 

1. Select the Insurance that you want to bill. (You will do this for each insurance to be filed 
for this Purchase Summary/Invoice: primary, secondary, etc) 

2. In the Estimated Price click on “amount unknown” if you are expecting a total denial from 
this insurance; otherwise enter the GRAND TOTAL of the Purchase Summary/Invoice. 
You only need one Due from insurance for each company, regardless of the number of 
HCFAs you will be filing off this Purchase Summary/Invoice. You can not create a 
HCFA if you have not entered a Due from Insurance. You can choose if you want to put 
any information under notes. Then push save and you will be taken back to the Purchase 
Summary/Invoice.  

1. Example 1: Medicare/Mplan patient (MPlan requires Medicare denial) You would have a 
Due from Insurance for Medicare with “amount unknown” checked (because you do not 
expect any payment from Medicare) and a Due from Insurance from MPlan for the 
GRAND TOTAL amount of the Purchase Summary/Invoice.  

2. Example 2: You expect a payment from the primary insurance company but do not know 
how much it will be. Create a Due from Insurance for the GRAND TOTAL amount of the 
Purchase Summary/Invoice for the primary insurance. For the subsequent insurances 
create a Due from Insurance with “amount unknown”. When the first insurance pays, 
change the amount of the secondary insurance Due from Insurance to the balance 
expected (GRAND TOTAL – primary insurance payment – write off). When the secondary 
insurance pays, change the Due from Insurance for the third insurance to reflect the 
balance of the claim amount, etc. Any amount not covered by a Due from Insurance 
(“amount unknown” or a dollar amount entered in Due from Insurance) will be dropped 
down to the amount owed by patient line of the Purchase Summary/Invoice. 

3. You will need to save this page again also 
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Hearing Aids and Audios 
When an audiologist sells Hearing Aids they MUST put them in the computer, or if the patient 
already has hearing aids those also need to be put in the computer since it is a new system. 
Audiologist need to also enter old Audios into the computer (within the last year) or the most 
current one. If a patient comes in for a clean and check the Audiologist needs to go ahead and put 
the OLD audio in the computer. If a patient comes in for an Audio then that also needs to be 
entered.  
**To get to this screen go to the Patient Summary and scroll down to Current Equipment and 
you will be able to EDIT the Hearing Aid information.  
**To edit an Audio click on the patients name scroll down to hearing loss and click on edit. 
Then you will be able to enter in the audio information. 
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Insurance Billing (HCFAs)  

At Patient Appointment Check Out  
After printing the Invoice (Patient Summary) to give to the patient and entering the Due from 
Insurance: 

1. Scroll down the screen and click on  cc rr ee aa tt ee   nneeww  hh cc ff aa 
2. Click on primary or secondary,  etc as appropriate 
3. Verify Clinic and Staff information is correct. 

4. Click on  SS ee ll eecc tt   AApppp tt   aa nn dd   PP uurr cchhaa ssee ss   ..   ..   ..  
5. Click on the line items you wish to bill insurance for 

6. Click on gg oo 
7. Scroll down to block 24 e and click in the 1, 2, 3 or 4 box that corresponds to the 

diagnosis code entered in block 21 which corresponds to the procedure on that line. 
8. Scroll down to block 31 and type the rendering audiologist’s signature line to replace 

“Signature on file” in that box. 
9. Review the other blocks on the hcfa according to the Claims Processing checklist, 

entering or changing information as necessary. 
10. When you are satisfied that hcfa (claim form) is correct and ready to be filed: 

a. If this is a claim to the primary insurance verify that the payer id block at the top 
of the screen under the insurance company name has a number in it.  

i. If it does, click on ss aavv ee   aa nn dd   ss uubb mmii tt   ee ll eecc tt rr oonn ii cc aa ll ll yy 
ii. If it does not you can not file this claim electronically.  

1. Click on ssaavv ee   aa nn dd   vv ii eeww   pp rr ii nn tt aa bb ll ee 
2. Print page 1 of the claim form on the back of a preprinted page 2. 
3. Close the viewable claim window. 
4. Click on edit status 
5. Select sent on paper from the drop-down list.  

6. ss aa vvee 
7. IMPORTANT. Do not ‘save’ again. If prompted to resend 

information do not do so. Simply cc ll ooss ee the HCFA screen 
b. If this is a claim to a subsequent insurance company (not the primary) then: 

1. Click on ssaavv ee   aa nn dd   vv ii eeww  pp rr ii nn tt aa bb ll ee 
2. Print page 1 of the claim form on the back of a preprinted page 2. 
3. Close the viewable claim window. 
4. Click on edit status 
5. Select sent on paper from the drop-down list.  

6. ss aa vvee 
7. IMPORTANT. Do not ‘save’ again. If prompted to resend 

information do not do so. Simply cc ll ooss ee the HCFA screen 
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At a later time than the appointment 
You have several ways to go back into the invoice (Purchase Summary) for the purpose of 
filing the HCFA if it is not done when you enter the charges: 

1. Go to the Patient Summary, scroll down to the appointment, or the invoice section and 
click on the appropriate link (mm/dd/yy) and proceed as above. 

2. Go to the HCFA Billing Report  

a. Select the clinic from the drop-down list 

b. Select unbilled only from the drop-down list 

c. Click on a link (mm/dd/yy) in the Purchase Date column to go directly to that 
invoice and create the HCFAs as above.  

d. When done cc ll oo ssee   the invoice screen and you will be back at the HCFA Billing 
Report, and you can go to another invoice and create the HCFAs 

3. Go to the appointment date on the actual schedule and click on the patient name 

a. Scroll down and click on the vv ii ee ww  rr ee ccee iipp tt   bbuu tt tt oo nn 

b. This takes you to the invoice, proceed as above. 
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Entering Insurance Payments 

Access the Purchase Summary (invoice) by any convenient means: 
  Type in patient name in the search box, click on the name, scroll down the Patient 

Summary, click on the date of the invoice in the invoice section. 
  Using the HCFA Billing Report, click on the date of service next to the appointment on 

the list. 
  Create the A/R Aging Report for the location and click on the receipt link next to the 

appointment in the list. 

1. Check the Due from Insurance amount on the invoice. It should equal the amount of the 
invoice UNLESS this insurance was filed only to obtain a denial, then it should say “Amount 
Unknown”. Edit this amount if it is not correct. If the claim was denied, simply click on 
denial next to the Due from Insurance entry on the Purchase Summary, and enter the reason 
for the denial in the notes box that pops up. 

2. Enter the amount of the payment. 

a. Click on ppaayy mmee nn tt  on the Purchase Summary (lower left portion of the screen) 
b. Select “Insurance” from the pull down list 
c. Enter amount of the payment in the amount box. 
d. Enter “testing”, “service”, “hearing aid”, “batteries”, “earmold” or “fee” in the 

description box as appropriate. You may also enter the name of the insurance after this 
word, or the specific service or test if there were several HCFAs filed for this invoice. 

e. Select the HCFA being paid from the drop-down list. Note: if you have received a 
payment before submitting a claim in Sycle (as for a Medicare Supplemental 
insurance payment) then be sure to indicate the insurance company in the description 
box.  Example: testing AARP payment. 

3. Enter a copay amount by clicking on the adjustment link next to the Due from Insurance line 
on the invoice. Change the amount in the box to the amount of the copay. Type ‘copay” in the 
notes box. This will move the copay amount to Due from the Patient if there is no other 
insurance to file. 

4. Enter a deductible, coinsurance, or patient responsibility amount in the same manner as a 
copay, using the appropriate word to substitute for copay in the notes box. 

5. Enter the write off amount by clicking on wwrr ii tt ee   oo ff ff (next to the Payment button). Select 
“Contractural adjustment” from the drop-down list. Click on the tt oo tt aa ll   aammoo uu nn tt . The 
remainder amount will appear. Accept this amount if it is correct, else adjust it according to 
the EOB. In the description box write, “testing”, “service”, “hearing aid”, “batteries”, 
“earmold” or “fee” as appropriate. 

6. If the patient has a balance owed at this point (copay, deductible, coinsurance, etc) and there 
is no other insurance to file, print out the Purchase Summary (invoice). Stick it in a window 
envelope and mail it. 

7. Create a HCFA for the next insurance company if any. (you can tell because there will be a 
Due from Insurance line on the invoice for primary, secondary, etc insurances on the invoice. 
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Notes on Insurance payments, adjustments and write offs. 
 

1. HCI contracts with BCBS and other insurance companies by choice. We have 
negotiated the amounts that we will be paid for various services. To find the 
contracted amount go to the Master Fee Schedule (Save on your desktop for easy 
access) 

2. The Allowed Amount on an EOB should equal the contract amount on the Master 
Fee Schedule. If it does not. You need to fill out an Adjustment form requesting 
the correct payment amount. DO NOT REFUND AN UNDER PAYMENT.  If no 
form is available contact the provider inquiry number and ask for assistance.  

3. The write-off amount is the difference between the Total Charges and Allowed 
Amount columns. This is the insurance contractual difference amount. For the 
contract with BCBS the Amio/Max are considered Usual and Customary 
(Standard). For those models we are to write off the difference between the HCI 
price list amount and the $1200 allowed amount. For models above that level we 
are to bill the patient for the difference between the contracted amount and the 
HCI list price, plus any deductible or coinsurance amount between the contractual 
amount (allowed) and the paid amount.  

a. Example if the patient buys an Amio the contracted amount is $1200. If the 
patient has a 80/20 plan they will be billed $240 for their coinsurance (20% 
of 1200.00). This should be indicated on the EOB. 

4. The Patient (Subscriber) Liability equals the Allowed Amount minus the 
Amount Paid. This is the amount that should be billed to the patient.  

a. To move this amount to the Due from Patient line on the Purchase 
Summary in Sycle, use adjust next to the Due from Insurance entry on the 
screen. Enter the amount of the liability in the amount box and type in the 
description: subscriber liability, coinsurance, etc. as appropriate in the 
description box. 

b. Print out the Statement by pressing on the Statement button on the screen.  
i. You can enter a stock phrase from MS Word, such as “Your 

insurance has paid its portion of your bill. The balance owing is 
your responsibility. Please pay promptly. Thank you.” in the memo 
section before you print the statement. (Create a document in MS 
Word, copy and paste into the statement memo section.) 

ii. Use the statement paper Tim has sent to each office for this 
purpose. 

iii. The date the statement has been mailed can be found in the Patient 
Summary invoices section.  

iv. On the back side of the statement print the Credit Card Payment 
Box. (From the Hearing Center Forms page online) 
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Vocational Rehabilitation Billing and Payments 

Billing 
Voc Rehab is only paying us a fee for dispensing hearing aids. They order, pay for and ship the 
hearing aids to us to dispense to the patient.  

When you receive the hearing aid from Voc Rehab enter it as an in-stock hearing aid into 
Inventory and designate it for the patient: 

Click on the Inventory section 

Scroll down to the BTE In Stock or Other In Stock section (as appropriate) and  click on 
aadddd  ttoo  iinn--ssttoocckk  

Enter the hearing aid information in the appropriate boxes. 

Change the cost and retail price to $0.00 

save  

Scroll down the Inventory screen to the BTE In Stock or Other In Stock section and 
click on gg oo to see the list of in stock hearing aids 

Next to the hearing aid you just entered click on sell 

Type in the patient name and click on ss eeaa rr cc hh   

Click on Sell next to the patient name on the screen 

Click on left or right 

Click on save from the Hearing Aid Purchase screen. This takes you to an invoice where 
a zero balance charge for the hearing aid has been entered. 

save  

Scroll down the screen and click on add next to services 

Scroll down to and highlight Fitting Fee/Voc Rehab (A1, A2, D1 or D2) 

save  

Scroll to the top of the screen page and make sure the bill to section has the Voc Rehab 
address (if not go into the Patient Summary and make Voc Rehab the Bill To “person” 
for this patient by entering Voc Rehab and its address in the appropriate blocks there. 

Print the invoice and mail to Voc Rehab in a window envelope. 
 
When you receive the payment from Voc Rehab, enter it as a check pp aa yymmee nn tt   on the invoice. In 
description enter “service, voc rehab” 

NOTE: if voc rehab approves the audiometric exam and pays for it, use “insurance 
contractural” as the write off type and enter “testing voc rehab” in the description box. 
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Hearing aid Repairs 
Sending in the repair: 

1. Type in the patient name in the search field and click on the patient name in the list. (Or 
click on name on the schedule) then click on the name again to get to the Patient Summary 
screen). 

2. Scroll down the Patient Summary to the current equipment section. 

3. The left and/or right hearing aid information is displayed for the current equipment. Next 
to the appropriate hearing aid click on the rr ee ppaa ii rr   button. 

4. The Repair Purchase screen appears. Select the hearing aid from the drop-down list 
(current and previous hearing aids for this patient will be in the drop-down list). 

5. Select the repair type from the drop-down list.  

6. Enter company name in the Sent to: block (where you are sending the aid for repair) 

7. Enter description of problem. 

8. click ss aavv ee 

9. You will be taken to an Invoice (Purchase Summary) screen. Print out this invoice to 
give to the patient and for the daily batch. 

10. Click ssaa vvee.  

The Inventory section now lists the hearing aid as out to the manufacturer for repair.  

When the repaired hearing aid is received: 
1. Click on the Inventory section next to the appointment schedule. 

2. Scroll down to the Repair Check-In section 

3. Click on the repaired box next to the entry in the list. Enter Invoice # and notes. 
4. Click ssaa vvee.  The Inventory section shows the hearing aid in Repairs to be delivered to 

Patient.  The patient has also been added to the Call list. 

When the hearing aid is delivered to the patient: 
1. Click on the Inventory section.  

2. Scroll down to the Repairs to be Delivered to Patient section.  

3. Click on the Delivered to Client box.  

4. Click on ssaavv ee. The delivery date is now displayed on the repair invoice and the Patient is 
removed from the list.  
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Hearing Aid Returns  
(patient brings hearing aid back during trial period and does not want any 
other hearing aid instead of it) 

This can be done two ways: 
1. Access the Patient Summary by doing a patient search and then clicking on the patient 

name. 

a. Scroll down the summary to the Current Equipment section 

b. Click on the rr ee tt uu rr nn   button for the appropriate hearing aid. 

c. A new screen appears. Confirm the return by clicking oo kk 

d. If patient has other hearing aids in Sycle a drop-down list will appear so you can 
select their current equipment by highlighting it, then click ookk 

e. You will be taken to the Purchase Summary (Invoice) for the returned hearing 
aid and the return will be added to the invoice for you. Sycle will calculate any 
refunds due to the patient or insurance automatically. Sycle also lists the return on 
the Hearing aid and sales reports.  

f. If a refund is reflected (Amount due insurance, or amount due to patient) on the 
invoice, click on the rr ee ffuu nn dd   button. ss aa vvee. Print the invoice to send with an 
adjustment form to Speedway, so a refund check can be issued to either the patient 
or insurance. 

g. Print the invoice for your daily batch.  

2. Access the purchase appointment 

a. If you know the appointment date for the hearing aid sale you can go to that date 
on the schedule and click on the patient name to go to the Appointment 
Summary.  

b. Click on vv ii ee ww  rr eecc ee ii pp tt. This takes you to the invoice.  

c. Click on return next to the hearing aid that is being returned. 

d. A new screen appears. Confirm the return by clicking on oo kk 

e. If patient has other hearing aids in Sycle a drop-down list will appear so you can 
select their current equipment by highlighting it, then click ookk 

f. Sycle will calculate any refunds due to the patient or insurance automatically. 
Sycle also lists the return on the Hearing aid and sales reports, and records it in the 
Patient Summary. 

g. If a refund is reflected on the invoice, click on the rr ee ffuu nn dd   button. ss aa vvee ..   Print the 
invoice to send with an adjustment form to Speedway, so a refund check can be 
issued to either the patient or insurance. 

h.  Print the invoice for your daily batch. 
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Hearing Aid Exchanges 
1. Access the Patient Summary by doing a patient search or clicking on the patient 

appointment on the schedule and then clicking on the patient name. 

2. Scroll down the summary to the Current Equipment section 

3. Click on the ee xx cchh aann ggee   button for the appropriate hearing aid. 

4. A new screen appears. Confirm the exchange by clicking oo kk 

5. The Hearing Aid Purchase screen appears. 

6. Select from the drop-down boxes the Manufacturer, type, model and battery size for the 
new hearing aid or from the Inventory list of in-stock aids. 

7. ss aa vvee   
8. At this time the old hearing aid appears as a return on the invoice and in the hearing aid 

reports. The new hearing aid appears on order in the Inventory section for the clinic. If 
you already have the new hearing aid, record the receipt in the Inventory section and 
record it delivered to patient at the time of the fitting. 

9. This will take you back to the original invoice. 

10. Sycle will calculate any refunds due to the patient or insurance automatically. Sycle also 
lists the exchange on the Hearing aid and sales reports, and records it in the Patient 
Summary.  In the Hearing Aid Sales Report it will show the correct number of hearing 
aids in the exchange section total. You must scroll to the far right to see the net balance of 
the transaction in the Balance Due column. 

11.  If there is a refund due to the patient or the insurance click on the refund button on the 
invoice to process the refund and then print out 2 copies of the invoice,. (one for your 
daily batch, and one to send in with the change of instrument form to Speedway. 
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Hearing Aid Replacement (Lost Hearing aid) 
1. Access the Patient Summary by doing a patient search or clicking on the patient 

appointment on the schedule and then clicking on the patient name. 

2. Scroll down the summary to the Current Equipment section 

3. Click on the rr eepp ll aacc ee   button for the appropriate hearing aid. 

4. The Replacement window appears. All the information from the lost hearing aid will fill 
in on this screen automatically. Scroll down to verify that in the second section of this 
screen the hearing aid purchase price is $200.00 (this is the replacement fee amount). If 
not, enter $200.00 into this field. The amount in the replacement fee field should be $0.00, 
because the patient will have to pay full price to replace the replacement hearing aid if 
they should also lose that one.  

5. Enter your PO # in the Tracking # field. 

6. ss aa vvee 
7. You will be taken to a Purchase Summary. The hearing aid exchange is already on the 

screen showing a purchase price of $200.00. Click on oo rr ddee rr   ff oo rr mm. 

8. Print the Order Form. 

9. Print the Purchase Summary for your daily batch. 

10. NOTE: to get back to this invoice you will need to view all equipment on the Patient 
Summary other equipment section and click on the date hyperlink. 

11. When replacement hearing aid arrives log it into the inventory as you would a new 
hearing aid order. An appointment reminder will be generated automatically. 
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How to close out a day… 
1. Click on the reports tab at the top of the screen. 
2. Under Sales Reports click on Sales 
3. Go to Sales Report For (enter your location) 
4. Under Period (Select Day) 
      At the end of the month, (Select Month) 
5. Check the date and make sure it is correct (date your closing) 
     At the end of the month (Select the month that you are closing) 
6. Then push GO on the right side of the screen 

A. Then Click on Download All and open and you can save the file to your 
computer. Make a file folder on your computer and name it Daily Closings. Also 
run your monthly closings and place in folder.  You can keep each day saved and 
save your monthly reports. 

7. Microsoft excel will open at this point. 
8. You want to click on the Sales0 tab (at the bottom of the screen). If you add up the charges (less 

sales tax) of all your Purchase Summary invoices for the day, the total should equal the total on this 
page.  

A. Then print the Sales0 tab.  (see sample) 

Sales 
Thu:Oct 
5th         Total         

Hearing Aid 1 $1600.00 1 $1600.00 
Earmold 0 $0.00 0 $0.00 
Hearing Test 0 $0.00 0 $0.00 
Battery 3 $0.00 3 $0.00 
Accessory 0 $0.00 0 $0.00 
Warranty 0 $0.00 0 $0.00 
Service 11 $625.00 11 $625.00 
Repair 0 $0.00 0 $0.00 
Remote 0 $0.00 0 $0.00 
Fee 0 $0.00 0 $0.00 
Sub Total 15 $2225.00 15 $2225.00 
Returns 0 $0.00 0 $0.00 
Replacements 0 $0.00 0 $0.00 
Total 15 $2225.00 15 $2225.00 

 
9. Next click on the “Invoices1” tab (at the bottom of the screen) and make sure the amount 

is correct. (Payments Total must match your Deposit Summary “Total for Location” 
amount for the day.)  

                   This is what the Invoices1 tab will look like… EXAMPLE: 

Payments 
Wed:Jul 

12th Total 
cash $14.00 $14.00 
visa $0.00 $0.00 

Payments 
Total $14.00 $14.00 

HA Deposits $0.00 $0.00 
Refunds $0.00 $0.00 

Write-Offs $0.00 $0.00 
 

                         
10. Then staple the Sales0 and Invoices1 print outs to the top of your Purchase Summary 

Invoices & EOB copies. (For the Close of the Day) All # must match. 
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Birthday Card Mailings – Do Monthly 
 

1. Click on Reports 

2. Click on Marketing 

3. Report Type: Birthdates 

4. Check Patient Type: Current 

5. Clinic: check your clinic name on the list 
66 ..   Select Birth Month: pick the month you want from the scroll down list  

77 ..   DDoo wwnn lloo aadd     

88 ..   OOpp ee nn   

9. Highlight rows 1 and 2. 

10. Click on the Edit menu. 

11. Click on Delete 

12. Review the list and remove any names that should not be getting a card (as decided by 
your office). 

13. Click on the File menu 

14. Click on “Save as” 

15. Click on the “Desktop” icon on the left side of the open window. 

16. Type in “Birthdates” 

17. click on “Save” You now have a document named Birthdates saved to your desktop. If 
prompted overwrite your Birthdates file from last month. 

18. In MS word open the Mailing Labels Template saved to your desktop (during Sycle 
training) 

19. click on Yes when prompted. 

20. Review labels and edit if needed 

21. Print labels, attach to cards. 

22. Enter patient birth date and current year 

23. have card signed 

24. Add post card stamps and mail cards 
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Six Month Reminders in Sycle – Do Monthly 

1. Click on Reports 

2. click on Marketing Lists 

3. Select from Report Type drop down: Custom Patient Groups 

4. Check Patient Type: Current 

5. Check   Clinic name 

6. Scroll down to pink area of screen 

7. Select Group: from the drop-down list select the group for the month you want. (Example 
you are sending May reminders, select “May/Nov 6 Mo Reminder”) 

8. click on Download   

9. Click Open  -- a MS Excel spreadsheet file will open on your desktop. 

10. In the spreadsheet --  highlight row 1 & row 2 

11. Access the Edit menu at the top of your screen and click on delete – row 1 should now 
contain only the column headings: First, Last, Preferred,  etc. 

12. Access the File menu at the top of your screen and click on Save as … 

13. A “Save As” window will open – Click on the Desktop icon in the left column of this 
window  

14. Type in the file name:  “Custom_Patient_Groups” (this should be the default)   

15. If asked say “yes” to overwrite an existing file with the same name. 

16. Open MS Word & print the labels  

a. Open file: (on the Desktop) “Mail Label Template.doc” 

1. Dialog boxes will open. Click “yes”, “open”, “ok” and “find data source” 
2. Click on the DESKTOP icon on the left side of the box.  
3. Click on the “Custom_Patient_Group” spreadsheet you created in step 15 

above and Click on OPEN.  
4. Another box should pop up, and the file name should be highlighted. 

Click on OK 

b. OR Open “Custom_Patient_Group Mail Label Template” if you created it as in 
step “e” below previously. 

c. Your new six month reminder list should pull into the file. If prompted say “yes” 
to allow the data from the database to be imported into the document.  

d. Review the labels and print them. 

e. Close the MS Word file without saving it. (this will keep Birthdates.xls as the 
datasource) OR  Save the template as “Custom_Patient_Group Mail Label 
Template”, and close the document. (this will allow you to just open this template 
next time and not have to find the datasource). 

17. Affix labels to post cards, add post card stamps and mail. 
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Three Year Reminders in Sycle – Do Monthly 

1. Click on Reports 

2. click on Marketing Lists 

3. Select from Report Type drop down: Provider & Purchase Date 

4. Check Patient Type: Current 

5. Check   Clinic name 

6. Scroll down to pink area of screen 

a. Provider: “Any” 

b. Purchase Date – Will default to the current month starting and ending dates 
(example May 1 2007  through May 31 2007) Roll back the year to three years ago 
in both boxes (2004 in the example). 

7. click on Download   

8. Click Open  -- a MS Excel spreadsheet file will open on your desktop. 

9. In the spreadsheet --  highlight row 1 & row 2 

10. Access the Edit menu at the top of your screen and click on delete – row 1 should now 
contain only the column headings: First, Last, Preferred,  etc. 

11. Access the File menu at the top of your screen and click on Save as … 

12. A “Save As” window will open – Click on the Desktop icon in the left column of this 
window  

13. Type in the file name:  “Provider_and_Purchase_Date” (this should be the default)   

14. If asked say “yes” to overwrite an existing file with the same name. 

15.  Open MS Word & print the labels  

a. Open file: (on the Desktop) “Mail Label Template.doc” 

i. Dialog boxes will open. Click “yes”, “open”, “ok” and “find data source” 
ii. Click on the DESKTOP icon on the left side of the box.  

iii. Click on the “Provider_and_Purchase_Date” spreadsheet you created in 
step 12 above and Click on OPEN.  

iv. Another box should pop up, and the file name should be highlighted. Click 
on OK 

b. OR Open “Provider_and_Purchase_Date Mail Label Template” if you created it as 
in step “f” below previously. 

c. Your new three-year reminder list should pull into the file. If prompted say “yes” 
to allow the data from the database to be imported into the document.  

d. Review the labels and print them. 

e. Close the MS Word file without saving it. (this will keep Birthdates.xls as the 
datasource) OR  Save the template as “Provider_and_Purchase_Date” Mail Label 
Template, and close the document. (this will allow you to just open this template 
next time and not have to find the datasource). 

16. Affix labels to the post cards, add post card stamps, and mail. 


